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MODUL 1
Penuntun Penggunaan PSpice
versi Cadence OrCAD

Daftar Isi
1.1 Tujuan dan sasaran . . . . . . . . . . . . . . . . . 1

1.2 Memulai Program SPICE . . . . . . . . . . . . . 2

1.1 Tujuan dan sasaran

Setelah mempelajari modul ini, praktikan/mahasiswa diharapkan mahir
menggunakan software CAD (Computer-Aided Design) PSPice yang dirilis
oleh Cadence, dan memahami cara menganalisis rangkaian elektronika meng-
gunakan program Spice. Ada beberapa fitur penting dalam software Ca-
dence OrCAD PSPice yang sebaiknya dipahami oleh praktikan/mahasiswa
sehingga dapat menjalankan praktikum dengan baik.

Pemodelan rangkaian menggunakan Spice dapat dilakukan dalam 2 mode,
yaitu mode desain Circuit Schematic dan mode programming Circuit
Text. Selama praktikum berlangsung, praktikan/mahasiswa akan menggu-
nakan programming Circuit Text. Mode ini memiliki keunggulan dalam
hal fleksibilitas dan portabilitas, dimana pengguna dapat lebih mudah men-
gontrol program Spice, terutama parameter sirkuit dan parameter simu-
lasinya.

Oleh karena itu, praktikan/mahasiswa wajib memahami teknik pengkodean
rangkaian dalam bentuk teks sirkuit, serta memahami instruksi-instruksi
analisis rangkaian.

1
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1.2 Memulai Program SPICE
Untuk memulai program SPICE, lakukan langkah-langkah berikut:

Langkah 1: Membuka program. Setelah menginstalasi software ap-
likasi OrCAD PSpice, Anda bisa membuka aplikasi bernama PSPice AD
Lite. Tampilan software aplikasi OrCAD PSPice AD Lite dapat dilihat
pada Gbr. 1.1. Pada gambar tersebut terlihat beberapa pengarah untuk

LANGKAH 1 beberapa jendela penting di dalam tampilan program.

Jendela 

Command 

Prompt

Jendela 

Output

 Status Bar

Jendela Status 

Simulasi

Jendela 

Cursor

Klik untuk melihat 

file sirkuit

Klik untuk melihat file 

teks output simulasi

Klik untuk melihat bentuk gelombang 

(waveform) hasil simulasi

Klik untuk mengubah 

setelan simulasi

Jendela 

Editor Utama

Gbr. 1.1: Jendela software aplikasi OrCAD.

• Jendela Editor Utama. Ada tampilan yang bisa ditunjukkan pada
jendela Editor Utama, yaitu:

1. Jendela tampilan untuk melihat dan mengedit file Text Circuit
dari sebuah rangkaian simulasi.

2. Jendela tampilan untuk melihat file Simulation Output, sesuai
dengan instruksi analisis dan instruksi untuk menampilkan data-
data variabel simulasi, seperti instruksi .PRINT, .FOUR, dsb.

2



1.2. MEMULAI PROGRAM SPICE

Aktivasi Jendela 

Command Prompt

Aktivasi 

Jendela 

Output

Aktivasi 

Status Bar

Aktivasi Jendela 

Status Simulasi

Aktivasi 

Jendela 

Cursor

Aktivasi 

Jendela 

Waveform

Aktivasi 

Jendela 

Output Text 

File

Aktivasi 

Jendela Circuit 

Text

Gbr. 1.2: Aktivasi jendela-jendela pada software aplikasi OrCAD.

3. Jendela tampilan untuk melihat bentuk gelombang atau Waveform
dari sinyal-sinyal yang akan diukur atau diamati. Instruksi .PROBE
diperlukan untuk menampilkan variabel-varibel simulasi pada
titik-titik simpul dan jalur-jalur simpal tertentu.

Gbr. 1.1memperlihatkan simbol icon di sisi kiri jendela aplikasi, yang
dapat di-klik untuk menampilkan jendela-jendela utama tersebut di
atas.

• Jendela Command Prompt. Dari jendela ini kita bisa memberi
instruksi simulasi. Namun demikian, sejauh ini pengguna akan jarang
memasukkan instruksi langsung dari jendela ini, kecuali pengguna
memahai semua bentuk-bentuk instruksi Spice.

• Jendela Output. Dari jendela ini kita bisa melihat output simulasi.
Ada 3 sub jendela tab yang dapat dilihat di sini, yaitu tab Analysis,
Watch dan Devices. Pada tabulasi Devices Anda dapat melihat list
jenis dan jumlah komponen yang ada dalam rangkaian yang sedang
disimulasi.
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MODUL 1. PENUNTUN PENGGUNAAN PSPICE VERSI CADENCE ORCAD

Bidang file aktif. Bila nama file 

terlihat pada bidang tersebut, 

maka file siap untuk disimulasi.

Klik icon Start Simulation ini 

untuk menjalankan simulasi

Gbr. 1.3: Tampilan program di dalam jendela Circuit Text.

• Jendela Status Simulasi. Dari jendela ini kita dapat melihat status
dari simulasi, termasuk kesalahan simulasi yang muncul serta penye-
babnya.

• Jendela Cursor. Dari jendela ini, kita dapat melihat informasi
mengenai titik-titik tertentu pada kurva gelombang sinyal dari hasil
simulasi seperti nilai maksimum, nilai minimum, nilai puncak (peak)
lokal maupun global, nilai titik belok kurva (trough), nilai kemiringan
kurva (slope) serta nilai-nilai pada titik-titik tertentu pada kurva.

• Status Bar. Dari Status Bar kita bisa melihat persentasi jalannya
proses simulasi.

Anda dapat mengatur keaktifan jendela-jendela tersebut dengan mengk-
lik salah satu item pada menu View, seperti terlihat pada Gbr. 1.2.

Langkah 2: Membuat file baru. Setelah jendela utama software PSPice
AD Lite terbuka, maka Anda dapat memulai membuat file Spice dalam
bentuk Circuit Text. Klik menu File>New>Text File atau tekan short-
cut Ctrl+N. Anda akan mendapatkan jendela editor yang kosong tempat

LANGKAH 2

4



1.2. MEMULAI PROGRAM SPICE

Rd

CF

VS

1 Vsens

RL

L1 L2

2 3
4

5

0

Gbr. 1.4: Diagram skematika acuan untuk Circuit Text pada List-
ing 1.1.

dimana program Circuit Text dituliskan.

Listing 1.1: Program Spice Pertama, Simulasi Filter
1 RANGKAIAN SIMULASI TANGGAPAN FILTER
2 VS 1 0 PULSE (0 220 0 1uS 1uS 10mS 20mS)
3 Vsens 1 2 0 ; b e r f u n g s i s e b a g a i s e n s o r a ru s
4 L1 2 3 1mH
5 L2 3 4 12mH
6 CF 3 5 120uF
7 Rd 5 0 1 .2
8 RL 4 0 1k
9 ∗ I n s t r u k s i a n a l i s i s

10 .TRAN 1uS 100mS 0 1uS
11 .FOUR 50Hz 100 V(4 , 0 ) I (RL)
12 .PROBE V(1 ,0 ) I ( Vsens ) V(4 , 0 ) I (RL)
13 .END

Sebagai program pertama, sesuai dengan diagram skematika rangka-
ian yang ditunjukkan pada Gbr. 1.4, tuliskanlah program pada List-
ing 1.1 ke dalam editor tadi, sehingga program tersebut terlihat seperti
pada Gbr. 1.3. Penjelasan setiap baris program adalah sebagai berikut: SPICE

• Baris 1: merupakan nama/judul rangkaian yang dapat secara bebas
dideskripsikan oleh pengguna. Catat bahwa baris judul pada baris pertama
ini harus dibuat.

• Baris 2: memperlihatkan deklarasi VS 1 0 yang menunjukkan sum-
ber tegangan V S pada titik node (1,0). Sumber tegangan berupa pulsa
yang dituliskan dalam bentuk PULSE (0 220 0 1uS 1uS 10mS 20mS) den-
gan bentuk umum PULSE (Vmin Vmax Td Tr Tf Duty Period), sehingga
masing-masing urutan parameter dijelaskan sbb:
V min: Nilai terendah dari pulsa (0 V);
V max: Nilai tertinggi dari pulsa (220 V);
Td: Waktu tunda pulsa (0 detik);
Tr: Waktu bangkit pulsa dari nilai terendah ke tertinggi (1 µDetik);
Tr: Waktu jatuh pulsa dari nilai tertinggi ke terendah (1 µDetik);
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MODUL 1. PENUNTUN PENGGUNAAN PSPICE VERSI CADENCE ORCAD

TDuty: Lebar waktu Duty pulsa, yaitu lebar waktu dimana pulsa bernilai
tertinggi (10 mDetik);
Period: Lebar perioda waktu pulsa (20 mDetik);

• Baris 3: memperlihatkan deklarasi Vsens 1 0 yang menunjukkan
sumber tegangan V sens pada titik node (1,2) dengan tegangan sebesar 0
Volt. Sumber tegangan 0 volt ini berfungsi untuk mengukur arus atau seba-
gai sensor arus. Teks setelah tanda semikolon “;” tidak akan diinterpretasi
oleh Spice (dapat digunakan untuk memberi kalimat komentar).

• Baris 4: menunjukkan induktor L1 pada titik node (2,3), dengan nilai
induktansi sebesar 1 mH.

• Baris 5: menunjukkan induktor L2 pada titik node (3,4), dengan nilai
induktansi sebesar 12 mH.

• Baris 6: menunjukkan kapasitor CF pada titik node (3,5), dengan
nilai kapasitansi sebesar 120 µF.

• Baris 7: menunjukkan resistor Rd pada titik node (5,0), dengan nilai
resistansi sebesar 1,2 Ω.

• Baris 8: menunjukkan resistor RL pada titik node (4,0), dengan nilai
resistansi sebesar 1 kΩ.

• Baris 9: Teks setelah tanda “*” tidak akan diinterpretasi oleh Spice
(dapat digunakan untuk memberi kalimat komentar)

• Baris 10: menunjukkan instruksi .TRAN untuk analisis tanggapan
waktu dengan parameter-parameter sbb: waktu step 1 µSmaksimum waktu
simulasi 100 mS, waktu awal simulasi 0 S, dan batas atas waktu step 1 µS.

• Baris 11: menunjukkan instruksi .FOUR untuk analisis Fourier atau
analisis spektrum harmonisa, dengan parameter-parameter sbb: frekuensi
dasar 50 Hz, jumlah harmonisa 100 titik, variabel yang diukur, dalam hal
ini V(1,0) dan I(RL).

• Baris 12: menunjukkan instruksi .PROBE untuk menampilkan variabel-
variabel terukur pada Jendela Waveform, yang diikuti oleh ekspresi variabel-
variabel terukur. Ekspresi tegangan pada instruksi .PROBE biasanya ditulis
dengan huruf awal “V” diikuit oleh angka/simbol node positif dan negatif
dipisahkan oleh tanda koma (“,”), yang dituliskan di dalam tanda kurung,
misalnya V(4,0), yang berarti tegangan terukur pada titik node 4,0. Ek-
spresi arus dituliskan dengan huruf awal “I” dan diikuti oleh elemen dimana
arus dilewati, yang dituliskan di dalam tanda kurung, misal I(RL), yang
berarti arus yang mengalir pada elemen RL

• Baris 13: menunjukkan instruksi .END menandakan akhir baris dari
program Spice.
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1.2. MEMULAI PROGRAM SPICE

Langkah 3: Menyimpan file. Setelah Anda mengetikkan file Circuit
Text ke dalam editor, maka selanjutnya simpanlah file tersebut ke dalam
format file .cir. Langkah-langkahnya dapat dilihat padaGbr. 1.5. Pertama,

LANGKAH 3
klik menu File>Save untuk pertma kali menyimpan file atau menu File>Save
As bila file telah disimpan sebelumnya. Setelah itu akan muncul jendela
Save AS untuk menyimpan file.

Pada jendela Save AS tersebut, pertama yang Anda lakukan adalah
meng-klik pilihan pada Save as type, lalu pilih Circuit Files (*.cir).
Kedua, tuliskan nama file (upayakan tanpa spasi) pada bidang isian File
name. Setelah itu, klik tombol Save, dan file Anda akan tersimpan dalam
format file circuit text (*.cir). Perlu dicatat bahwa file teks sirkuit
dalam program Spice disimpan dengan ekstensi .cir.

1. Klik pilihan pada Save as type, 

lalu pilih “Circuit Files (*.cir)” 2. Tuliskan 

nama file

3. Klik Save

Gbr. 1.5: Langkah untuk menyimpan file Circuit Text.
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Langkah 4: Membuka file dan mensimulasikannya. Setelah file baru
tersimpan, maka file tersebut tidak serta merta akan dapat disimulasi, ke-
cuali nama file tersebut telah tampil pada bidang file aktif.

LANGKAH 4
Perhatikan kembali Gbr. 1.3. Pada gambar tersebut terlihat nama

file yang tertulis pada bidang file aktif. Bila nama file tersebut belum
muncul, maka Anda perlu membuka file teks sirkuit tersebut. Klik menu
File>Open. Maka jendela untuk membuka file akan terlihat seperti pada
Gbr. 1.6. Pertama, klik pilihan pada Files of type, lalu pilih Circuit
Files (*.cir). Kedua, pilihlah dengan meng-klik file yang ingin Anda
buka hingga nama file yang dipilih akan muncul pada bidang File name.
Setelah itu, klik tombol Open, sehingga file circuit text, .cir tersebut akan
muncul pada jendela editor, dan nama file yang dibuka tadi akan muncul
pada bidang file aktif. Kliklah simbol icon simulasi untuk menjalankan
simulasi.

1. Klik pilihan pada Files of type, 

lalu pilih “Circuit Files (*.cir)”

2. Piliha file yang 

ingin dibuka

3. Klik Open

Gbr. 1.6: Langkah untuk membuka file Circuit Text.
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1.2. MEMULAI PROGRAM SPICE

Langkah 5: Membuka Jendela Waveform danMenambahkan Kurva
Simulasi. Setelah menjalankan simulasi, terutama untuk pertama kali
menjalankan simulasi, maka biasanya jendela Waveform akan kosong. Oleh
karena itu, kita perlu menambahkan kurva atau menambahkan trace pada
jendela tersebut. Langkah-langkahnya dapat dilihat pada Gbr. 1.7.

LANGKAH 5Pada jendela Add Traces tersebut Anda dapat menambahkan ekspresi
variabel terukur dengan cara meng-klik salah satu atau dua variabel beru-
rutan di dalam jendela Simulation Output Variables, sehingga variabel-
variabel tersebut muncul pada bidang isian Trace Expression. Pada gam-
bar terlihat, bahwa 2 variabel yaitu V(4,0) dan I(RL) telah dipilih.

Pada sisi kanan dalam Gbr. 1.7 terdapat pula jendela Function or
Macros, yang menunjukkan beberapa fungsi dan macro yang dapat digu-
nakan untuk mengoperasikan variabel dengan fungsi-fungsi tersebut. Seba-
gai contoh Anda dapat meng-klik fungsi AVG() kemudian meng-klik variabel
V(4,0 sehingga pada bidang Trace Expression akan tertulis AVG(V(4,0)),
yang mana fungsi tersebut akan menampilkan tegangan rata-rata variabel
V(4,0) ke dalam jendela Waveform.

Pilih satu atau lebih variabel yang ingin 

ditampilkan pada Jendela Waveform

Bidang isian yang memperlihatkan 

ekspresi variabel-varibel yang akan 

ditampilkan dalam Jendela Waveform

Daftar fungsi 

operasi terhadap 

variabel yang 

dapat dipilih 

untuk ditampilkan 

dalam Jendela 

Waveform

Klik tombol OK 

bila telah selesai 

memilih ekspresi 

variabel-variabel

Gbr. 1.7: Jendela untuk menambahkan trace kurva variabel atau
ekspresi variabel ke dalam Jendela Waveform.
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Langkah 6: Mengamati Cursor dari setiap kurva. Setelah Anda
menambahkan trace kurva ke dalam Jendela Waveform, maka Anda akan
mendapatkan hasil seperti terlihat padaGbr. 1.8. Jendela Waveform dapat

LANGKAH 6
aktifkan dengan cara meng-klik simbol icon View Simulation Results di
sisi kanan Jendela Utama. Pada sisi kiri-bawah jendela, terdapat legenda
simbol dan warna kurva ekspresi variabel luaran yang diukur. Kurva dari
variabel-variabel terukur terlihat dalam jendela Waveform sesuai dengan
warna dan simbol pada legenda tersebut.

Cursor merupakan penunjuk nilai pada titik-titik tertentu pada kurva.
Untuk mengaktifkan dan menonaktifkan Cursor, Anda dapat meng-klik
simbol pointer seperti terlihat dalam Gbr. 1.8. Setelah di-klik, jendela
Cursor pada sisi kanan-bawah serta merta akan terbuka. Ada 2 kursor
yang bisa aktif, yaitu Cursor Merah dengan cara meng-klik-kiri Mouse lalu
ditahan dan digeser-geser, dan Cursor Hijau dengan cara meng-klik-kanan
Mouse lalu ditahan dan digeser-geser.

Klik untuk menampilkan 

Jendela Waveform

Kurva variabel 

V(4,0)
Kurva variabel 

V(1,0)

Klik untuk mengaktifkan 

atau menonaktifkan Cursor

Legenda ekspresi 

variabel-variabel

Simbol-simbol icon 

untuk memilih jenis 

pengukuran Cursor

Jendela Cursor akan 

muncul bila Icon aktivasi 

Cursor di atas di-klik

Gbr. 1.8: Jendela Waveform dan pengamatan Cursor setiap
kurva.

Untuk lebih jelasnya perhatikan Gbr. 1.9. Arahkan mouse ke simbol
variabel V(1,0) pada legenda kurva (kiri-bawah), lalu klik-kiri. Arahkan
mouse ke Jendela Waveform. Klik kiri, tahan dan geser-geser mouse. Per-
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1.2. MEMULAI PROGRAM SPICE

hatikan nilai-nilai kurva pada jendela Cursor di sisi kanan-bawah gam-
bar. Setelah itu, arahkan mouse ke simbol variabel V(4,0) pada legenda
kurva (kiri-bawah), lalu klik-kanan. Arahkan mouse ke Jendela Waveform.
Klik kanan, tahan dan geser-geser mouse. Perhatikan nilai-nilai kurva pada
jendela Cursor di sisi kanan-bawah gambar. Jendela Cursor juga mem-
perlihatkan selisih antara Cursor Merah untuk kurva variabel V(1,0) dan
Cursor Hijau untuk kurva variabel V(4,0).

1. Arahkan Mouse 

ke simbol variabel 

V(1,0), lalu klik kiri 

mouse

2. Arahkan Mouse ke 

simbol variabel V(4,0), 

lalu klik kanan mouse

Perhatikan nilai-nilai kurva setiap 

variabel ketika cursor digeser-geser

Cursor Hijau

Cursor Merah

Gbr. 1.9: Cara menggunakan Cursor pada Jendela Waveform.

Simbol-simbol icon untuk memilih jenis pengukuran pada kurva juga
terlihat dalam gambar tersebut. Dengan memilih salah satu jenis pen-
gukuran tersebut, kita dapat melihat informasi mengenai titik-titik ter-
tentu pada kurva gelombang sinyal dari hasil simulasi seperti nilai mak-
simum (Cursor Max), nilai minimum (Cursor Min), nilai puncak (Cursor
Peak) lokal maupun global, nilai titik belok kurva (Cursor Trough), nilai
kemiringan kurva (Cursor Slope) serta nilai-nilai pada titik-titik tertentu
pada kurva. Bila kurva memiliki banyak titik puncak lokal/global dan
banyak kemiringan, maka meng-klik-klik ulang simbol Cursor Peak, Cur-
sor Trough atau Cursor Slope akan memindahkan ke titik-titik pengukuran
yang dimaksud.
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Langkah 7: Menambah Jendela Plot di dalam Jendela Waveform.
Setelah menambahkan trace kurva ke dalam Waveform, Anda juga bisa
menambahkan jendela Plot baru ke dalam jendela Waveform. Langkah-
langkah adalah sebagai berikut. Klik Menu Plot>Add Plot to Window
seperti terlihat pada Gbr. 1.10. Setelah meng-klik menu tersebut, maka

LANGKAH 7 sebuah Jendela Plot yang baru akan ditampilkan ke dalam jendela Waveform
yang sama namun dengan sumbu terpisah.

Seperti terlihat di dalam gambar, pada jendela Waveform akan terlihat
sebuah penanda teks tertulis SEL» yang menunjukkan Jendela Plot yng ak-
tif. Bila Anda melakukan penambahan trace kurva yang baru, maka kurva
tersebut akan ditampilkan pada jendela plot yang aktif, atau yang memiliki
penanda SEL». Untuk menambahkan trace kurva ke dalam jendela terse-
but, selain menggunakan metode klik seperti dijelaskan sebelumnya, Anda
dapat pula mengetik secara manual instruksi seperti AVG(V(4,0)), V(4,0,
I(RL) dan/atau variabel/fungsi lain ke dalam bidang Trace Expression.

Penanda “SEL>>” 

menunjukkan 

Jendela Plot 

yang aktif

Jendela Plot yang 

baru ditambahkan Klik Add Plot to Window 

untuk menambah Jendela 

Plot dalam Jendela 

Waveform

Jendela Cursor

Gbr. 1.10: Jendela untuk menambahkan jendela plot ke dalam
Jendela Waveform.
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Langkah 8: Membuka Jendela Teks Output Simulasi. Selain Jen-
dela Waveform Spice juga dapat menghasilkan luaran hasil simulasi yang
disimpan dalam bentuk teks. Instruksi-instruksi yang digunakan untuk
menampilkan luaran dalam bentuk teks seperti .PRINT, .FOUR, .TEMP, dsb.
Gbr. 1.11. Sesuai dengan instruksi .FOUR 50Hz 100 V(4,0) I(RL) yang

LANGKAH 8tertera pada Baris ke-11 dari Listing 1.1, maka hasil simulasi spektrum
harmonisa ditunjukkan pada Jendela Teks Hasil Simulasi tersebut.

Jendela Teks Output Simulasi dapat diaktifkan atau ditampilkan dengan
cara meng-klik icon simbol View Simulation Output File yang terdapat
pada sisi kiri Jendela Editor Utama.

Klik untuk menampilkan 

Jendela Teks Output 

Simulasi

Tampilan Teks 

Output Simulasi

Gbr. 1.11: Jendela tampilan teks output simulasi.
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Langkah 9: Mengekspor Jendela Waveform ke Clipboard. Diagram
kurva pada Jendela Waveform dapat diekspor menjadi file gambar yang akan
di-copy ke Clipboard komputer Anda, sehingga dapat disisipkan (paste) ke
dalam aplikasi word processor seperti Microsoft Word. Langkah-langkahnya

LANGKAH 9 adalah sebagai berikut.
Klik Menu Window>Copy to Clipboard. Setelah itu, Anda akan melihat

jendela Copy to Clipboard - Color Filter seperti terlihat padaGbr. 1.12.
Pada bagian Background pastikan pilihan tunggal make window and plot
background transparent tercentang, agar menghasilkan gambar dengan
latar belakang transparan. Ada tiga pilihan Foreground, yaitu pilihan use
screen colors untuk menghasilkan gambar yang persis sama dengan gam-
bar di layar, pilihan change white to black untuk mengubah garis latar
putih/abu-abu menjadi hitam dengan kurva tetap berwarna, dan pilihan
change all colors to black untuk semua warna kurva menjadi warna
hitam. Dua pilihan terakhir adalah yang terbaik untuk menyisipkan gam-
bar ke aplikasi Word Processor.

Pilih Foreground 

“change all colors 

to black” untuk 

mengubah semua 

warna kurva ke 

warna hitam

Gbr. 1.12: Jendela untuk men-copy Jendela Waveform ke Clip-
board.

Setelah meng-klik tombol OK, maka Anda membuka aplikasi word pro-
cessor dan mem-paste atau mem-paste special gambar dengan pilihan gam-
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1.2. MEMULAI PROGRAM SPICE

bar bitmap atau metafile pada posisi cursor yang diinginkan. Gbr. 1.13
memperlihatkan 2 buah hasil gambar yang telah disisipkan ke aplikasi
word/graphic processor dengan menggunakan 2 pilihan tadi yaitu masing-
masing dengan pilihan change white to black dan pilihan change all
colors to black.

           Time

0s 20ms 40ms 60ms 80ms 100ms
V(1,0) V(4,0)

-400V

0V

400V

           Time

0s 20ms 40ms 60ms 80ms 100ms
V(1,0) V(4,0)

-400V

0V

400V

Gbr. 1.13: Bentuk gambar yang telah disisipkan dengan 2 opsi.

Sebelummeng-copy-paste gambar, Anda dapat pula lebih dahulu mengedit
kurva seperti mengubah warna, pola, ketebalan dan simbol garis kurva.
Untuk melakukan hal tersebut, Anda cukup meng-klik salah satu kurva
di dalam Jendela Waveform kemudian, meng-klik-kanan Mouse Anda, se-
hingga muncul jendela dengan beberapa menu. Dari jendela tadi pilih Menu
Trace Property, sehingga muncul jendela untuk mengubah warna, pola,
ketebalan dan simbol garis kurva tadi. Kemudian klik tombol OK untuk
melihat hasilnya.
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MODUL 2
Piranti dan Komponen
Elektronika Daya

Daftar Isi
2.1 Tujuan dan sasaran . . . . . . . . . . . . . . . . . 17
2.2 Landasan Pemahaman . . . . . . . . . . . . . . . 18
2.3 Soal-soal Teori Dasar . . . . . . . . . . . . . . . . 19
2.4 Persiapan Alat dan Bahan . . . . . . . . . . . . . 20
2.5 Pelaksanaan . . . . . . . . . . . . . . . . . . . . . . 20

2.5.1 Model SPICE Rangkaian SCR . . . . . . . . . . 20
2.5.2 Model SPICE Rangkaian IGBT . . . . . . . . . . 22
2.5.3 Model SPICE Rangkaian Power MOSFET . . . 24
2.5.4 Hasil Simulasi dan Analisis . . . . . . . . . . . . 25
2.5.5 Perancangan dan Pengujian Alat . . . . . . . . . 26

2.6 Rangkuman . . . . . . . . . . . . . . . . . . . . . . 26

2.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami fungsi dari
piranti-piranti dan komponen-komponen penting yang digunakan dalam
rangkaian elektronika daya.

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari piranti-
piranti yang digunakan dalam rangkaiam elektronika daya, serta mem-
odelkannya dalam program Spice.
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2.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ada banyak macam piranti dan komponen elektronika daya yang pent-
ing untuk dipelajari. Secara umum, komponen-komponen elektronika daya
dibagi atas komponen pasif dan komponen aktif. Untuk komponen aktif
seperti resistor, induktor dan kapasitor, kita tidak akan banyak membahas
di sini, tetapi untuk aplikasi elektronika daya komponen-komponen terse-
but harus memiliki rating tegangan di atas 300V. Pada dasarnya, tidak ada
konvensi yang mengatur batasan tetap atas tegangan operasi setiap piranti
elektronika daya, tapi kita bisa mengambil contoh rating operasi sebuah
dioda daya (power diode) seperti terlihat pada Tabel 2.1.

Tabel 2.1: Contoh rating operasi dari sebuah piranti dioda daya.
Voltage Rating : upto 4000 V
Current Rating : upto 3500 A
Upper Frequency : 1 kHz
ON State Voltage Drop : hampir 1 V

Untuk komponen aktif, dapat dibagi menjadi 2 bagian yaitu komponen
untuk sirkuit konverter daya dan komponen untuk untuk sirkuit kendali.
Komponen untuk sirkuit konverter yang cukup banyak digunakan dalam ap-
likasi adalah Power MOSFET, Power BJT, IGBT, Thyristor SCR, Thyristor
GTO, TRIAC, dan Power Diode. Contoh-contoh fotografi komponen sak-
lar elektronik berupa transistor yang banyak digunakan dalam rangkaian
elektronika daya dapat dilihat pada Gbr. 2.1.

(a) IGBT (b) MOSFET (c) SiC MOSFET (d) GaN MOSFET

Gbr. 2.1: Fotografi piranti elektronika daya.

Sedangkan komponen untuk sirkuit kendali dapat dibagi menjadi unit
chipset kontroler elektronis, chipset driver, optocoupler, dan regulator tegan-
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gan. Komponen sirkuit kendali ini pada dasarnya bukan merupakan ele-
men utama rangkaian elektronika daya. Namun demikian, tanpa kehadiran
elemen-elemen tersebut, implementasi rangkaian elektronika daya mustahil
direalisasikan.

2.3 Soal-soal Teori Dasar

Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh maha-
siswa sebelum memulai praktikum. Jawablah pertanyaan-pertanyaan terse-
but pada Lembar Kerja yang disediakan.

1. Jelaskan perbedaan dan kesamaan antara Dioda dan Thyristor! Ke-
mudian gambarkan simbol Dioda dan Thyristor serta tunjukkan nama-
nama terminalnya!

2. Apakah kepanjangan dari SCR dan GTO serta apa perbedaan men-
dasar antara SCR, GTO dan TRIAC? Gambarkanlah simbol dari
SCR, GTO dan TRIAC serta tunjukkan nama-nama terminalnya!

3. Apakah kepanjangan dari IGBT dan apa perbedaan antara Power
BJT, IGBT Power MOSFET? Lalu gambarkanlah simbol Power BJT,
IGBT dan Power MOSFET serta tunjukkan nama-nama terminalnya!

4. Apakah kepanjangan dari SiC FET dan GaN FET? Jelaskan kelebi-
hannya dibandingkan dengan Power MOSFET berbasis silikon biasa!

5. Sebutkan 4 jenis rangkaian elektronika daya ditinjau dari segi bentuk
konversi daya masukan dan luarannya!

6. Sebutkan komponen-komponen yang diperlukan untuk mendesain se-
buah rangkaian elektronika daya yang lengkap! Anda dapat membuat
diagram blok untuk menjelaskan jawaban Anda.

7. Cobalah telusuri dari sumber internet misalnya: www.mouser.com,
www.element14.com, www.digikey.com atau dari situs web vendor
langsung komponen, untuk mencari komponen-komponen yang di-
tanyakan beserta dokumen datasheetnya pada tabel di dalam lembar
kerja yang disediakan. Lengkapilah isian tabel yang ditanyakan di
dalam lembar kerja tersebut.
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2.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

1. Komputer dekstop/laptop dengan program SPICE yang sudah terin-
stall di dalamnya.

2. Mikrokontroler kit yang berfungsi untuk membangkitkan sinyal pulsa.

3. Osiloskop analog/digital untuk mengukur sinyal-sinyal analog dan dig-
ital.

4. Perangkat Suplai Daya Listrik (Power Supply).

5. Komponen-komponen resistor, kapasitor, mikrokontroler, optocoupler
TLP250, MOSFET IRFP460, MOSFER Driver IR2110, SCR TYN812,
dsb.

2.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini. Ada 3 jenis piranti yang akan
diuji yaitu Thyristor SCR, Power MOSFET dan IGBT.

2.5.1 Model SPICE Rangkaian SCR
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk rangkaian elektronika daya sederhana menggunakan Thyristor SCR.
Thyristor SCR tidak terdapat dalam model Spice standard. Model ekivalen
SCR (model skematika dan Spice) dapat dilihat dalam buku [Muhammad
Rasyid, 2006], “SPICE for Power Electronics and Electric Power, 2nd edi-
tion”. Model ekivalen Spice SCR ditulis kembali seperti terlihat pada List-
ing 2.1.SPICE

Rangkaian
Ekivalen SCR Listing 2.1: Program Spice Model Ekivalen SCR

1 ∗ S u b c i r c u i t f o r AC t h y r i s t o r model
2 .SUBCKT SCRMOD 1 3 2
3 ∗ model name anode (1 ) +c o n t r o l ga te (3 ) cathode (2 )
4 S1 1 5 6 2 SMOD ; Switch
5 RG 3 4 50
6 VX 4 2 DC 0V
7 VY 5 7 DC 0V
8 DT 7 2 DMOD ; Switch d i ode
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9 RT 2 6 1
10 CT 6 2 10uF
11 F1 2 6 POLY(2) VX VY 0 50 11
12 .MODEL SMOD VSWITCH (RON=0.0105 ROFF=10E+5 VON=0.1V VOFF=0V)
13 .MODEL DMOD D( IS =2.2E−15 BV=1200V TT=0 CJO=0) ; Diode model
14 .ENDS SCRMOD

Setelah menuliskan program Spice untuk model ekivalen SCR, maka
model tersebut dapat digunakan dalam program Spice rangkaian SCR seder-
hana seperti ditunjukkan pada Listing 2.2. Penjelasan baris-baris program
adalah sebagai berikut: Adapun gambar acuan dari teks sirkuit Spice terse- SPICE

Rangkaian SCR
Sederhanabut diperlihatkan pada Gbr. 2.2.

R

VS

VX

0

1

2

3

4

Vg

XT1

Gbr. 2.2: Diagram skematika acuan untuk Circuit Text pada List-
ing 2.2.

Listing 2.2: Program Spice Rangkaian SCR sederhana
1 Rangkaian T h y r i s t o r SCR sede rhana
2 .PARAM Ampl = 220V
3 .PARAM Freq = 50Hz
4 .PARAM DelayAng le = 100
5 .PARAM PulseWidth = 500 us
6 VS 1 0 SIN (0 {Ampl} { Freq })
7 Vg 4 0 PULSE (0 15 {{ De layAng le }/{360∗{ Freq }}} 1 ns 1 ns
8 + { PulseWidth } {1/{ Freq }})
9 R 1 2 2 .5

10 VX 2 3 DC 0V ; Sumber tegangan 0 s e b a g a i s e n s o r a ru s
11 . INC SCRmodel . c i r ; menyertakan model t h y r s i t o r SCR
12 XT1 3 4 0 SCRMOD ; T h y r i s t o r T1
13 ∗ .STEP PARAM DelayAng le L i s t 30 60 90
14 .TRAN 0 .5US 100MS 0 0 .5 uS
15 .PROBE V(1 ,0 ) V(3 , 0 ) V(4 , 0 ) I (VX) I (R)
16 .END

• Baris 1: menunjukkan nama/judul rangkaian. Seperti biasa baris
judul ini harus ada di dalam file teks sirkuit.
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• Baris 2–5: menunjukkan parameter-parameter simulasi yang akan
digunakan dalam elemen-elemen progam rangkaian.

• Baris 6: menunjukkan sumber tegangan berupa sinyal sinusoidal den-
gan nilai amplitudo dan frekuensi yang ditetapkan seperti pada parameter-
paramater pada baris 2 dan 3.

• Baris 7, 8: merupakan sumber tegangan berupa pulsa dengan parameter-
parameter penting untuk mengaktifkan SCR, yaitu parameter waktu tunda
pulsa DelayAngle. Waktu tunda pulsa dirumuskan ke dalam sintaks PULSE
seperti terlihat pada baris program tersebut yaitu DelayAngle

360∗F req
, lebar pulsa

aktif diset sebagai PulseWidth dan perioda pulsa dirumuskan sebagai 1
F req

.
Pada baris ke-8 tanda “+” menunjukkan kelanjutan baris program sebelum-
nya.

• Baris 11: merupakan sintaks untuk menyertakan file sirkuit teks yang
lain. Listing program untuk file SCRmodel.cir diperlihatkan pada List-
ing 2.1.

• Baris 12: memperlihatkan penyertaan subsirkuit SCRMOD yang se-
lalu diawali dengan huruf “X”. Perhatikan baik-baik urutan nomor simpul
pada baris tersebut dengan urutan nomor pada baris ke-2 di dalam List-
ing 2.1. Urutan tersebut menunjukkan hubungan satu-satu setiap nomor
simpul pada subsirkuit sesuai dengan urutannya.
Tahapan pelaksanaan praktikum untuk rangkaian SCR sederhana ini adalah
sebagai berikut:

1. Tuliskanlah program tersebut dalam editor utama software PSpice
AD Lite!

Tahapan
Pelaksanaan

(Simulasi
Rangkaian SCR)

2. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

3. Tampilkanlah kurva daya dan daya rata-rata yang mengalir pada sim-
pul cabang (1,0)! Cara menampilkan kurva daya dan kurva daya rata-
rata dapat dilihat pada Bagian 2.5.4.

4. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

2.5.2 Model SPICE Rangkaian IGBT
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk untuk rangkaian elektronika daya sederhana menggunakan IGBT.
Listing 2.3 memperlihatkan program Spice rangkaian IGBT sederhana.
Karena penjelasan mengenai program Spice telah diberikan sebelumnya,
maka hanya beberapa penjelasan baris-baris program terutama yang baru
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yang akan dijelaskan sebagai berikut: Adapun gambar acuan dari teksSPICE
Rangkaian IGBT

Sederhana sirkuit Spice tersebut diperlihatkan pada Gbr. 2.3.

Rd

x20

Edriver

Z1

VS

Vsense

0

12

0

3
45

Vpulse

Gbr. 2.3: Diagram skematika acuan untuk Circuit Text pada List-
ing 2.3.

Listing 2.3: Program Spice Rangkaian IGBT sederhana
1 Rangkaian IGBT sede rhana
2 .PARAM Per i od = 20ms
3 .PARAM Duty = 0 .4 ; Batas n i l a i (0<Duty <1)
4 .PARAM PulseAmpl = 1 .2V
5 VS 1 0 230
6 Vsens 1 2 0 ; s e b a g a i s e n s o r a ru s
7 Rd 2 3 100
8 Z1 3 4 0 IXGH40N60
9 .MODEL IXGH40N60 NIGBT (TAU=287.56E−9 KP=50.034 AREA=37.500E−6

10 + AGD=18.750E−6 VT=4.1822 KF=.36047 CGS=31.942E−9
11 + COXD=53.188E−9 VTD=2.6570)
12 Vpu l se 5 0 PULSE (0 { PulseAmpl } 0 1 ns 1 ns {Duty∗ Pe r i od } { Pe r i od })
13 E d r i v e r 4 0 5 0 20
14 .TRAN 0 .5US 100MS 0 0 .5 uS
15 .PROBE V(2 ,3 ) V(3 , 0 ) I ( Vsens ) V(4 , 0 ) V(5 , 0 )
16 .END

• Baris 8: merupakan ekspresi elemen IGBT yang diawali dengan hu-
ruf “Z”, yaitu Z1 3 4 0 IXGH40N60, yang berarti terminal Collector, Base,
Emitter masing-masing terhubung ke simpul 3, 4 dan 0, yang mana IGBT
yang digunakan menggunakan nama model IXGH40N60.

• Baris 9, 10, 11: merupakan ekspresi model IGBT IXGH40N60 yang
berjenis NIGHT (tipe kanal N) yang diikuti oleh nilai-nilai parameter dari
IGBT tersebut. Tanda “+” pada baris 10 dan baris 11 menunjukkan lanju-
tan dari baris sebelumnya.

• Baris 12: menunjukkan sumber tegangan berupa pulsa dengan ampi-
tudo tertinggi sebesar PulseAmpl, siklus duty sebesar Duty*Period dan pe-
rioda pulsa sebesar Period yang mana parameter-parameter tersebut telah
ditetapkan pada baris 2, 3 dan 4.
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• Baris 13: menunjukkan sumber tegangan yang dikendalikan oleh
tegangan yang diawali dengan huruf “E”, yaitu Edriver 4 0 5 0 20 yang
berarti tegangan luaran pada simpul (4,0) tergantung pada tegangan pada
simpul (5 0) dikalikan dengan faktor pengali “20” seperti tertera pada baris
program tersebut. Jadi bila V(5,0) bernilai 1.2 V, maka V(4,0) akan
bernilai 1.2 × 20=24 V.
Tahapan pelaksanaan praktikum untuk rangkaian IGBT sederhana ini adalah
sebagai berikut:

1. Tuliskanlah program tersebut dalam editor utama software PSpice
AD Lite!

Tahapan
Pelaksanaan

(Simulasi
Rangkaian IGBT)

2. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

3. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

2.5.3 Model SPICE Rangkaian Power MOSFET
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE un-
tuk untuk rangkaian elektronika daya sederhana menggunakan MOSFET.
Listing 2.4 memperlihatkan program Spice rangkaian MOSFET seder-
hana. Karena penjelasan mengenai program Spice telah diberikan sebelum-
nya, maka hanya beberapa penjelasan baris-baris program terutama yang
baru yang akan dijelaskan sebagai berikut: Adapun gambar acuan dari teksSPICE

Rangkaian
MOSFET

Sederhana
sirkuit Spice tersebut diperlihatkan pada Gbr. 2.4.

Rd

20

Edriver

M1
VS

Vsense

0

12

Vpulse

5 4

3

0

Gbr. 2.4: Diagram skematika acuan untuk Circuit Text pada List-
ing 2.4.

• Baris 8: merupakan ekspresi elemen MOSFET yang diawali dengan
huruf “M”, yaitu M1 3 4 0 0 IRF150, yang berarti terminal Drain, Gate,
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Source dan Bulk masing-masing terhubung ke simpul 3, 4, 0 dan 0, yang
mana MOSFET yang digunakan menggunakan nama model IRF150.

• Baris 9, 10, 11: merupakan ekspresi model MOSFET IRF150 yang
berjenis NMOS yang diikuti oleh nilai-nilai parameter dari MOSFET tersebut.
Tanda “+” pada baris 10 dan baris 11 menunjukkan lanjutan dari baris
sebelumnya.

Listing 2.4: Program Spice Rangkaian Power MOSFET sederhana
1 Rangkaian Power MOSFET sede rhana
2 .PARAM Per i od = 20ms
3 .PARAM Duty = 0 .4 ; Batas n i l a i (0<Duty <1)
4 .PARAM PulseAmpl = 1 .2V
5 VS 1 0 230
6 Vsens 1 2 0 ; s e b a g a i s e n s o r a ru s
7 Rd 2 3 100
8 M1 3 4 0 0 IRF150
9 .MODEL IRF150 NMOS (TOX=100N PHI=.6 KP=20.53U W=0.3 L=2U

10 +VTO=2.831 RD=1.031M RDS=444.4K CBD=3.229N PB=0.8 MJ=0.5
11 +CGSO=9.027N CGDO=1.679N RG=13.89 IS =194E−18 N=1 TT=288N)
12 Vpu l se 5 0 PULSE (0 { PulseAmpl } 0 1 ns 1 ns {Duty∗ Pe r i od } { Pe r i od })
13 E d r i v e r 4 0 5 0 20
14 .TRAN 0 .5US 100MS 0 0 .5 uS
15 .PROBE V(2 ,3 ) V(3 , 0 ) I ( Vsens ) V(4 , 0 ) V(5 , 0 )
16 .END

Tahapan pelaksanaan praktikum untuk rangkaian Power MOSFET seder-
hana ini adalah sebagai berikut:

1. Tuliskanlah program tersebut dalam editor utama software PSpice
AD Lite!

Tahapan
Pelaksanaan
(Simulasi
Rangkaian
MOSFET)

2. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

3. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

2.5.4 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari setiap rangkaian elektronika daya tersebut.
Gambar hasil simulasi waveform dapat dilakukan dengan menggunakan
template yang disediakan seperti pada Gbr. 2.5 atau langsung men-copy- SIM

paste dari jendela Waveform software PSpice AD Lite. Penjelasan mengenai
cara memindahkan gambar kurva sudah dijelaskan pada modul praktikum
sebelumnya.
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Gbr. 2.5: Hasil simulasi program SPICE.

Untuk mengukur atau menambahkan kurva daya yang mengalir pada
suatu cabang ke dalam jendela Waveform, maka variabel yang dibutuhkan
adalah beda potensial atau tegangan pada dua titik simpul cabang dan arus
yang mengalir pada cabang tersebut. Misalnya tegangan pada simpul ca-
bang (1,0) diekspresikan sebagai V(1,0) dan arus pada cabang diekspresikan
sebagai I(Vx), maka langkah-langkah berikut Anda lakukan untuk menam-
bahkan kurva daya dan/atau kurva daya rata-rata pada cabang tersebut.

1. Pilih jendela Plot tempat dimana kurva itu ditambahkan;

2. Klik menu Trace>Add Trace atau ketik tombol Insert pada key-
board komputer Anda!

3. Setelah jendela Add Traces muncul, ketikkanlah pada bidang isian
Trace Expression eskpresi berikut: V(1,0)*I(Vx).

4. Untuk menampilkan kurva daya rata-rata, ketikkanlah pada bidang
isian Trace Expression eskpresi berikut: Avg(V(1,0)*I(Vx)).

2.5.5 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

2.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
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Adapun hal-hal yang perlu diinvestigasi lebih jauh dan dapat dirangkum
di dalam laporan adalah sbb:

1. Apakah ada pengaruh PulseWidth yang diterapkan pada terminal
gate SCR terhadap arus dan tegangan luaran SCR?

2. Bagaimana hubungan tendensi antara sudut penyalaan SCR terhadap
daya dan daya rata dari yang dihasilkan pada terminal luaran dari
contoh rangkaian SCR yang diberikan pada buku penuntun ini?

3. Praktikan/mahasiswa dapat menyimpulkan apa manfaat SCR dalam
aplikasi rangkaian elektronika daya terutama dikaitkan dengan pen-
gaturan aliran daya?

4. Apakah ada pengaruh level tegangan yang diterapkan pada terminal
Gate MOSFET terhadap besar arus listrik yang mengalir dari termi-
nal Drain ke terminal Source dari MOSFET tersebut?
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MODUL 3
Penyearah Berbasis Thyristor
SCR

Daftar Isi
3.1 Tujuan dan sasaran . . . . . . . . . . . . . . . . . 29

3.2 Landasan Pemahaman . . . . . . . . . . . . . . . 30

3.3 Soal-soal Teori Dasar . . . . . . . . . . . . . . . . 30

3.4 Persiapan Alat dan Bahan . . . . . . . . . . . . . 30

3.5 Pelaksanaan . . . . . . . . . . . . . . . . . . . . . . 31

3.5.1 Pemrograman SPICE . . . . . . . . . . . . . . . 31

3.5.2 Hasil Simulasi dan Analisis . . . . . . . . . . . . 33

3.5.3 Perancangan dan Pengujian Alat . . . . . . . . . 34

3.6 Rangkuman . . . . . . . . . . . . . . . . . . . . . . 34

3.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami fungsi dari
piranti Thyristor SCR (Silicon Controlled Rectifier) dalam rangkaian
elektronika daya

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja rangkaian
penyearah berbasis Thyristor SCR.
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3.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Rangkaian penyearah (Rectifier) secara umum dapat dibagi ke dalam 2
kelas ditinjau dari sisi pasivitasnya, yaitu penyearah pasif dan penyearah
aktif. Penyearah yang dirancang menggunakan dioda sambungan PN bi-
asa termasuk dalam golongan penyearah yang pasif. Disebut pasif karena
aliran daya pada rangkaian tidak dapat dikendalikan. Penyearah yang
dibangun menggunakan komponen SCR bersifat aktif karena aliran daya
dalam rangkaian dapat diatur. Pengaturan aliran daya dapat dilakukan
dengan cara mengatur sudut penyalaan (firing angle) dari SCR. Pengatu-
ran sudut penyalaan tersebut secara langsung akan mengatur waktu aktif
SCR, sehingga secara tidak langsung daya yang mengalir melalui rangkaian
penyearah dapat diatur.

3.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

1. Apakah yang dimaksud dengan rangkaian penyearah (rectifier cir-
cuit)?

2. Sebutkan dan jelaskan secara singkat dimana saja rangkaian penyearah
ditemukan (sebutkan minimal 3 bidang aplikasi)!

3. Rangkaian penyearah (berbasis Dioda) dapat dibagi ke dalam rangka-
ian penyearah gelombang setengah dan gelombang penuh. Gambarkan-
lah dan jelaskanlah perbedaan kedua rangkaian tersebut!

3.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:
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1. Komputer dekstop/laptop dengan program SPICE yang sudah terin-
stall di dalamnya.

2. Mikrokontroler kit yang berfungsi untuk membangkitkan sinyal pulsa.

3. Osiloskop analog/digital untuk mengukur sinyal-sinyal analog dan dig-
ital.

4. Perangkat Suplai Daya Listrik (Power Supply).

5. Komponen-komponen resistor, mikrokontroler, optocoupler MOC8043,
SCR TYN812, dsb.

3.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

3.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE un-
tuk beberapa rangkaian elektronika daya yang akan dipelajari. Ada 2 jenis
rangkaian yang akan dianalisi dan diuji. Perhatikan rangkaian penyearah
berbasis SCR seperti ditunjukkan pada Gbr. 3.1 dan rangkaian penyearah
SCR-Dioda seperti ditunjukkan pada Gbr. 3.2.

T1 T2

T3 T4

RL

Vsens

VS

Gbr. 3.1: Diagram skematika rangkaian penyearah berbasis SCR.

Tahapan pelaksanaan praktikum untuk rangkaian penyearah berbasis SCR
ini adalah sebagai berikut:

1. Tuliskanlah program Spice dalam editor utama software PSpice AD
Lite untuk rangkaian SCR yang ditunjukkan pada Gbr. 3.1, dengan
parameter-parameter sbb:

Tahapan
Pelaksanaan
(Tuliskan Program
Spice)31



MODUL 3. PENYEARAH BERBASIS THYRISTOR SCR

• Tuliskanlah nomor simbol pada setiap simpul rangkaian seperlunya.
Tetapkan titik Ground dengan nomor simbol “0”!
• Tetapkan nilai R secara bebas antara nilai 100Ω hingga 1kΩ!
• Tetapkanlah VS sebagai sumber tegangan dengan amplitudo bebas
antara 100 hingga 230 Volt, dan frekuensi 50 Hz!
• Tetapkan nilai Vsens = 0 yang berfungsi sebagai elemen perantara
untuk mengukur arus listrik!
• Gunakan model sub-sirkuit SCR yang digunakan pada praktikum
sebelumnya!
• Terapkanlah sumber tegangan pulsa pada terminal gate dari setiap
SCR T1, T2, T3 dan T4 dengan benar, lalu aturlah sudut penyalaan
SCR dengan benar pada sudut-sudut tertentu!
• Tuliskanlah variabel-variabel tegangan dan arus listrik masukan dan
luaran setelah instruksi .PROBE!

2. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

3. Tampilkanlah kurva tegangan listrik masukan VS, kurva arus listrik
masukan (I(V sens)), kurva tegangan luaran (pada terminalRL), kurva
arus pada beban RL, kurva daya dan daya rata-rata yang mengalir
pada beban RL!

4. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

T1 T2

D1 D2

RL

Vsens

VS

Gbr. 3.2: Diagram skematika rangkaian penyearah berbasis SCR
dan Dioda.

Tahapan pelaksanaan praktikum untuk rangkaian penyearah berbasis SCR
dan Dioda adalah sebagai berikut:
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1. Tuliskanlah program Spice dalam editor utama software PSpice AD
Lite untuk rangkaian SCR-Dioda yang ditunjukkan pada Gbr. 3.2,
dengan parameter-parameter seperti pada program Spice sebelumnya.

Tahapan
Pelaksanaan
(Tuliskan Program
Spice 2)

2. Untuk piranti Dioda, gunakan model piranti seperti ditunjukkan di
bawah ini.

DX anoda katoda DMOD
.MODEL DMOD D(IS=2.2E-15 BV=1200V CJO=1PF TT=0)

Pada contoh di atas, dioda DX, kaki-kakinya terhubung ke titik sam-
bung anoda dan katoda dengan nama model DMOD, yang mana pada
baris berikutnya ditunjukkan deklarasi model DMOD tersebut. Nama
model misalnya DMOD dapat dituliskan dengan sebuah teks kata secara
bebas.

3. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

4. Tampilkanlah kurva tegangan listrik masukan VS, kurva arus listrik
masukan (I(V sens)), kurva tegangan luaran (pada terminalRL), kurva
arus pada beban RL, kurva daya dan daya rata-rata yang mengalir
pada beban RL!

5. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

3.5.2 Hasil Simulasi dan Analisis

Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika penyearah
SCR tersebut. SIM

Komentarilah hasil simulasi Anda, terutama dalam hal bagaimana SCR
diaktifkan melalui pulsa penyalaan yang diterapkan ke terminal gate SCR,
serta pengaruh sudut penyalaan tersebut terhadap aliran daya pada rangka-
ian. Bila perlu buatlah tabel yang menampilkan aliran daya rata pada
terminal luaran penyearah untuk beberapa nilai sudut penyalaan.

Cara untuk menampilkan kurva daya rata-rata telah dijelaskan pada
modul praktikum sebelumnya.
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3.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

3.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:

1. Penjelasan mengenai perbedaan bentuk gelombang yang dihasilkan
oleh penyearah berbasis Dioda dan penyearah berbasis SCR.

2. Penjelasan mengenai perbedaan dan/atau persamaan antara rangka-
ian penyearah jembatan penuh berbasis SCR dengan penyearah jem-
batan penuh gabungan antara SCR dan Dioda.

3. Prinsip kerja pengaturan sudut penyalaan piranti SCR dan pengaruh
sudut penyalaan SCR terhadap daya yang dialirkan oleh penyearah
SCR.

4. Manfaat utama dari rangkaian penyearah SCR.
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4.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami berbagai je-
nis inverter DC-AC satu-fasa, dan menjelaskan dengan baik fungsi-
fungsi dari setiap komponen rangkaian inverter DC-AC satu fasa;

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari inverter
DC-AC satu fasa;

3. Praktikan/mahasiswa mampu mendesain inverter DC-AC satu-fasa
sesuai dengan spesifikasi yang diberikan.
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MODUL 4. INVERTER SATU-FASA

4.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Konverter DC-AC atau disebut juga sebagai inverter merupakan salah
satu rangkaian elektronika daya yang berfungsi mengubah tegangan DC
(Direct Current) menjadi tegangan AC (Alternating Current). Inverter da-
pat dikategorikan ke dalam beberapa jenis. Ditinjau dari jumlah fasanya,
inverter dapat dibagi menjadi inverter satu-fasa (fasa tunggal) dan tiga-fasa
(fasa majemuk). Saat ini telah berkembang pula jenis-jenis inverter dengan
fasa lebih daripada tiga. Modul ini hanya akan membahas jenis inverter
DC-AC satu-fasa.

Ditinjau dari jumlah level atau tingkatan tegangan luaran, inverter DC-
AC dapat dibagi atas inverter satu-tingkat dan inverter banyak tingkat atau
Multilevel Inverter, misalnya dua-tingkat, tiga-tingkat, empat-tingkat, dsb.
Jumlah tingkatannya sangat tergantung pada konfigurasi rangkaian dan
jumlah saklar elektronik (transistor switch) yang digunakan dalam rangka-
iannya. Semakin banyak tingkatannya, maka semakin banyak pula jumlah
saklar elektronik yang dibutuhkan untuk mengimplementasikannya.

Jenis inverter DC-AC satu tingkat merupakan yang jenis yang paling
tradisional. Namun penerapannya masih banyak ditemukan di industri-
industri. Dua jenis inverter DC-AC satu tingkat, yang sangat terkenal
adalah inverter dengan struktur jembatan-setengah (Half-Bridge Inverter)
dan struktur -jembatan-penuh (Full-Bridge Inverter). Jenis-jenis inverter
multilevel yang cukup dikenal antara lain adalah Inverter Multilevel Dioda-
Jepitan atau Diode-Clamped Multilevel Inverter, Inverter dengan Kapasitor
Mengambang atau Flying Capacitor Multilevel Inverter, dan Inverter Jem-
batan H Terhubung Bertingkat atau Cascade H-Bridge Inverter. Inverter
Dioda-Jepitan biasa juga disebut sebagai Inverter Titik Netral Jepitan atau
Inverter Neutral Point Clamped (NPC).

Ditinjau dari cara pembangkitan pulsa kendali untuk membangkitkan lu-
aran inversi, maka teknik pembangkitan pulsa kendali inverter dapat dibagi
atas teknik gelombang kotak dan gelombang SPWM (Sinusoidal Pulse-
Width Modulation). Jenis lain inverter yang juga cukup terkenal adalah
Inverter Pulsa Resonan (Resonant-Pulse Inverter).

Ditinjau dari jenis sumber masukan atau variabel yang akan dikenda-
likan, maka inverter dapat dibagi atas tipe inverter sumber arus atau Cur-
rent Source Inverter (CSI) dan inverter sumber tegangan atau Voltage
Source Inverter (VSI). Pada CSI, arus masukan dipertahankan agar mendekati
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4.3. SOAL-SOAL TEORI DASAR

titik konstan. Oleh karena itu, rangkaian CSI biasanya dilengkapi dengan
rangkaian chopper sederhana pada sisi input yang kadang dilengkapi juga
dengan filter sederhana. Pada beberapa contoh, rangkaian CSI biasanya
diimplementasi dengan melibatkan SCR.

4.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

1. Sebutkan dan jelaskan secara ringkas dimana saja inverter DC-AC
diterapkan! (minimal 4 bidang aplikasi)

2. Apakah perbedaan mendasar antara Inverter Sumber Arus (CSI) den-
gan Inverter Sumber Tegangan (VSI)?

3. Jelaskan dan gambarkan susunan rangkaian inverter jembatan seten-
gah dan jembatan penuh!

4. Jelaskan prinsip kerja Inverter Pulsa Resonan!

5. Jelaskan perbedaan mendasar antara Inverter Multilevel Dioda-Jepitan
atau Diode-Clamped Multilevel Inverter dan Inverter Jembatan H Ter-
hubung Bertingkat atau Cascade H-Bridge Inverter !

4.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

1. Komputer dekstop/laptop dengan program SPICE yang sudah terin-
stall di dalamnya.

2. Mikrokontroler kit yang berfungsi untuk membangkitkan sinyal pulsa.

3. Osiloskop analog/digital untuk mengukur sinyal-sinyal analog dan dig-
ital.

4. Perangkat Suplai Daya Listrik (Power Supply).

5. Komponen-komponen resistor, kapasitor, mikrokontroler, optocoupler
TLP250, MOSFET IRFP460 atau MOSFET IRF150, Power Diode
IN4004 (rating di atas 230V), MOSFER Driver IR2110, dsb.
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MODUL 4. INVERTER SATU-FASA

4.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini. Pada bagian ini, praktikan
akan dituntut untuk mendesain sebuah rangkaian inverter DC-AC dua-
tingkat (jenis Diode-Clamped Multilevel Inverter) serta sinyal PWM yang
dibutuhkan, agar dihasilkan tegangan luaran yang diinginkan.

4.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE un-
tuk beberapa rangkaian elektronika daya yang akan dipelajari. Perhatikan-SPICE

lah rangkaian inverter DC-AC multilevel (dua-level) satu-fasa jenis Dioda-
Jepitan seperti terlihat pada Gbr. 4.1.
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Gbr. 4.1: Diagram skematika rangkaian Inverter Satu-Fasa jenis
Dioda-Jepitan (Diode-Clamped Multilevel Inverter).

Tahapan pelaksanaan praktikum untuk rangkaian inverter ini adalah seba-
gai berikut:

1. Tuliskanlah program Spice dalam editor utama software PSpice AD
Lite untuk rangkaian Inverter yang ditunjukkan pada Gbr. 4.1, den-
gan parameter-parameter sbb:

Tahapan
Pelaksanaan

(Tuliskan Program
Spice) 38
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• Tuliskanlah nomor simbol pada setiap simpul rangkaian seperlunya.
Tetapkan titik Ground dengan nomor simbol “0”!

• Tetapkan nilai R secara bebas antara nilai 100Ω hingga 1kΩ!

• Tetapkan nilai C1 dan C2 secara bebas antara nilai 10µF hingga
50µF!

• Tetapkanlah VSource sebagai sumber tegangan DC 110 hingga 230
Volt!

• Tetapkan nilai VCL = VCS = 0 yang berfungsi sebagai elemen per-
antara untuk mengukur arus listrik!

• Gunakan model Dioda sebagai berikut!
.model DIN750 D(Is=880.5E-18 Rs=0.25 Ikf=0 N=1 Xti=3 Eg=1.11
Cjo=175p M=0.5516 Vj=0.75 FC=0.5 Isr=1.859n Nr=2 Bv=4.7 Ibv=20.245m
Nbv=1.6989 Ibvl=1.9556m Nbvl=14.976)

• Gunakan model NMOS sebagai berikut!
.model IRF150 NMOS (VTO=2.83 KP=31.2U L=1U W=30M CGDO=0.418N
CGSO=2.032N)

• Terapkanlah sumber tegangan pulsa pada terminal gate dari setiap 8
saklar elektronis NMOS S1, S2, S3, S4, S5, S6, S7 dan S8 dengan tepat
dan benar, sehingga dihasilkan luaran inverter dua-tingkat dengan pe-
rioda 20 mS atau berfrekuensi 50 Hz, seperti terlihat pada Gbr. 4.2!

Catatan Penting: Pada setiap penerapan sumber tegangan pulsa
untuk sebuah NMOS, titik positif sumber tegangannya terhubung
ke terminal Gate sedangkan titik negatifnya terhubung ke terminal
Source dari NMOS tersebut, bukan ke titik Ground.
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Gbr. 4.2: Bentuk luaran inverter yang diinginkan.

• Amplitudo tegangan pulsa pada gate NMOS dapat Anda tetapkan
bebas antara 20V hingga 40V.
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MODUL 4. INVERTER SATU-FASA

• Tuliskanlah variabel-variabel tegangan, terutama tegangan pulsa
yang diterapkan pada tiap terminal gate NMOS, arus pada beban
dan tegangan luaran setelah instruksi .PROBE!

2. Simulasikanlah program tersebut, lalu tampilkan variabel-varibel yang
dituliskan pada instruksi .PROBE ke dalam jendela Waveform!

3. Tampilkanlah kurva tegangan listrik luaran inverter, kurva arus pada
beban RL (I(VCL)), kurva daya dan daya rata-rata yang mengalir
pada beban RL!

4. Pada jendela Waveform yang berbeda atau terpisah, tampilkan pula
tegangan pulsa yang diterapkan pada tiap terminal gate NMOS!

5. Pindahkanlah gambar kurva simulasi dai Jendela Waveform ke Lembar
Kerja yang disediakan. Lalu jelaskan apa yang Anda dapatkan dari
hasil simulasi tersebut!

4.5.2 Hasil Simulasi dan Analisis
Bagian terpenting dalam mendesain program Spice adalah menganalisis
bentuk-bentuk timing pulsa yang perlu diberikan agar inverter menghasilkan
tegangan luaran seperti terlihat pada Gbr. 4.2. Disarankan agar praktikan
menganalisis aliran arus untuk setiap kondisi on-state saklar NMOS.

Sebagai contoh, bila S1, S2, S7 dan S8 ON, sedangkan S3, S4, S5 dan S6
OFF, maka akan diperoleh tegangan luaran maximum. Bila S2 dan S3 ON,
sedangkan S1 dan S4 OFF, maka akan diperoleh tegangan luaran setengah
dari tegangan maksimum tadi. Analisis aliran arus dapat pula dilakukan
dengan bantuan Program Spice.

Setelah menuliskan program SPICE, praktikan/mahasiswa akan men-
ganalisis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya
tersebut.SIM

4.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

4.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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1. Penjelasan mengenai cara kerja atau prinsip kerja inverter dioda-
jepitan.

2. Penjelasan disertai gambar bentuk pulsa kendali yang perlu diter-
apkan ke tiap-tiap terminal Gate transistor NMOS, agar dihasilkan
tegangan luaran multi tingkat.

3. Pembahasan mengenai pengaruh amplitudo tegangan pulsa yang dit-
erapkan pada terminal gate NMOS terhadap amplitudo tegangan lu-
aran inverter.
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MODUL 5
Konverter DC-DC

Daftar Isi
5.1 Tujuan dan sasaran . . . . . . . . . . . . . . . . . 43
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5.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal, memahami dan menjelaskan
fungsi-fungsi dan jenis-jenis konverter DC-DC.

2. Praktikan/mahasiswa mampu menetapkan parameter-parameter kon-
verter DC-DC dengan tepat sehingga menghasilkan performa yang
diinginkan.

3. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari konverter
DC-DC penurun, penaik dan penurun-penaik tegangan.
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5.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Konverter DC-DC atau bisa juga disebut sebagai rangkaian Chopper1

merupakan salah satu jenis rangkaian elektronika daya yang berfungsi men-
gubah level tegangan DC ke level tegangan DC yang lain. Ditinjau dari
perubahan level tegangannya, secara umum konverter DC-DC dapat dibagi
atas konverter penurun tegangan (step-down converter) atau buck converter,
konverter penaik tegangan (step-up converter) atau boost converter dan
konverter penurun/penaik tegangan atau buck-boost converter. Ketiga jenis
konverter DC-DC ini akan dibahas dalam praktikum kali ini.

Selain itu. konverter DC-DC juga dapat dikategorikan berdasarkan do-
main polaritas kerja arus dan tegangan outputnya. Berdasrkan hal terse-
but, maka konverter DC-DC dapat dioperasikan ke dalam 4 buah kuadran
operasi. Di antaranya adalah daerah operasi kuadran I (tegangan output
positif, arus output positif), daerah operasi kuadran II (tegangan output
positif, arus output negatif), daerah operasi kuadran III (tegangan output
negatif, arus output negatif) dan daerah operasi kuadran IV (tegangan out-
put negatif, arus output positif). Namun demikian, dalam praktikum ini
kita tidak membahas lebih jauh mengenai kategori ini.

Seiring perkembangan jaman, telah banyak jenis-jenis konverter DC-DC
yang telah dikembangkan oleh praktisi industri dan oleh akademisi. Salah
satu jenis konverter DC-DC jenis buck-boost converter yang cukup terkenal
adalah konverter SEPIC (Single-Ended Primary Inductive Converter). Se-
lain itu, konverter DC-DC jenis pompa muatan (Charge Pump) juga banyak
ditemukan dalam berbagai bidang aplikasi elektronika terpadu dan elek-
tronika daya. Salah satu jenis konverter DC-DC pompa muatan yang paling
mendasar adalah rangkaian Dickson Charge Pump, yang bekerja menggu-
nakan prinsip pemompaan muatan pada kapasitor-kapasitor oleh dua buah
pulsa kendali yang diterapkan rangkaian.

Konverter DC-DC memiliki peranan yang sangat penting di era energi
terbarukan dan era kendaraan listrik dan listrik hibrida, termasuk juga
dalam berbagai aplikasi industri. Dalam aplikasi pengendalian motor listrik
DC, yang disuplai oleh sumber listrik DC berupa baterai yang konstan, kon-
verter DC-DC ini berfungsi menyediakan output level tegangan DC yang

1Beberapa referensi mendefinisikan Chopper sebagai rangkaian yang mengkonversi
secara langsung tegangan DC konstan ke berbagai level tegangan DC tertentu yang
berbeda
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5.3. SOAL-SOAL TEORI DASAR

bervariasi. Kenaikan dan penurunan level tegangan listrik DC akan mem-
berikan impak pada kecepatan putar dan daya listrik yang diterapkan ke
motor DC. Sebaliknya dalam berbagai aplikasi energi terbarukan, konverter
DC-DC banyak berfungsi menyediakan level tegangan listrik yang konstan
dari sumber tegangan listrik yang berubah-ubah. Sebagaimana kita ketahui,
sumber listrik energi terbarukan bersifat ambient, yaitu karakteristik kese-
diaannya yang tidak konstan dan tidak mudah ditebak. Rangkaian pengisi
baterai dalam aplikasi sistem fotovoltaik adalah salah satu contoh kasus
penerapan konverter DC-DC tersebut.

5.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

1. Sebutkan dan jelaskan ciri-ciri yang membedakan rangkaian Charge
Pump dengan rangkaian konverter DC-DC yang lain pada umumnya!

2. Salah satu rangkaian Charge Pump yang sangat terkenal adalah rangka-
ian Dickson Charge Pump. Gambarkan dan jelaskan secara singkat
prinsip kerjanya!

3. Sebutkan minimal 3 wilayah aplikasi dari rangkaian konverter DC-
DC!

5.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

1. Komputer dekstop/laptop dengan program SPICE yang sudah terin-
stall di dalamnya.

2. Mikrokontroler kit yang berfungsi untuk membangkitkan sinyal pulsa.

3. Osiloskop analog/digital untuk mengukur sinyal-sinyal analog dan dig-
ital.

4. Perangkat Suplai Daya Listrik (Power Supply).
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5. Komponen-komponen resistor, kapasitor, induktor, mikrokontroler,
optocoupler TLP250, MOSFET IRFP460 atau MOSFET IRF150,
Power Diode IN4004 (rating di atas 230V), MOSFER Driver IR2110,
dsb.

5.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini. Ada 3 jenis rangkaian konverter
DC-DC yang akan disimulasikan dan diujicobakan dalam praktikum kali
ini, yaitu konverter DC-DC jenis buck converter, boost converter dan jenis
buck-boost converter.

5.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk 3 jenis rangkaian rangkaian konverter DC-DC yang akan dipelajari
pada bab ini, yaitu rangkaian buck converter, boost converter dan rangkaian
buck-boost converter.SPICE

L

C
ZLD VoutVin

.... .... ....

0

M
....

Gbr. 5.1: Diagram skematika rangkaian konverter penurun tegan-
gan (Buck Converter).

Tahapan pelaksanaan praktikum untuk rangkaian chopper ini adalah seba-
gai berikut:

1. Tuliskanlah masing-masing program Spice dalam editor utama soft-
ware PSpice AD Lite untuk rangkaian Chopper yang ditunjukkan
pada Gbr. 5.1, Gbr. 5.2 dan Gbr. 5.3dengan parameter-parameter
sbb:

Tahapan
Pelaksanaan

(Tuliskan Program
Spice)

• Tuliskanlah nomor simbol pada setiap simpul rangkaian seperlunya.
Tetapkan titik Ground dengan nomor simbol “0”!
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LIN
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Gbr. 5.2: Diagram skematika rangkaian konverter penaik tegan-
gan (Boost Converter).
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Gbr. 5.3: Diagram skematika rangkaian konverter penurun/pe-
naik tegangan (Buck-Boost Converter).

• Tetapkan beban ZL sebagai resistor dengan nilai secara bebas antara
nilai 100 Ω hingga 1 kΩ!
• Tetapkan nilai C secara bebas antara nilai 10 µF hingga 100 µF!
• Tetapkan nilai L secara bebas antara nilai 10 µH hingga 10 mH!
• Tetapkanlah Vin sebagai sumber tegangan DC yang nilainya antara
45 V hingga 50 Volt!
• Tetapkanlah frekuensi dan rasio duty yang tepat dari pulsa yang
diterapkan pada transistor MOSFET M!
• Gunakan model Dioda dan MOSFET seperti pada praktikum se-
belumnya!

5.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but. Analisis terhadap hasil simulasi berfokus pada tiga hal: SIM

1. Hubungan atau keterkaitan antara nilai induktansi induktor terhadap
frekuensi kerja dari saklar elektronik. Baik nilai induktor dan frekuensi
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penyaklaran (switching frequency), keduanya mesti disetting secara
tepat untuk menghasilkan performa zang diharapkan, yaitu berupa
riple atau ayunan tegangan luaran DC yang cukup kecil.

2. Batasan nilai induktor terhadap spesifikasi daya luaran yang akan
dihasilkan oleh rangkaian chopper tersebut.

3. Hubungan antara rasio duty pulsa penyaklaran dengan level tegangan
luaran yang dihasilkan.

5.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

5.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:

1. Penjelasan dan analisa hubungan atau keterkaitan antara nilai induk-
tansi induktor terhadap frekuensi kerja dari saklar elektronik.

2. Penjelasan dan analisa hubungan antara nilai induktor terhadap daya
luaran yang akan dihasilkan oleh rangkaian chopper tersebut.

3. Penjelasan dan analisa hubungan antara rasio duty pulsa penyaklaran
dengan level tegangan luaran yang dihasilkan.
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Inverter 3-Fasa dan Kendali
Motor Listrik
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6.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami fungsi dari
piranti-piranti dan komponen-komponen penting yang digunakan dalam
merancang inverter 3-fasa.

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari inverter
3-fasa dan penerapannya untuk mengendalikan motor listrik.
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MODUL 6. INVERTER 3-FASA DAN KENDALI MOTOR LISTRIK

6.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ditinjau dari jumlah fasa luarannya inverter DC-AC dapat dibagi atas
inverter fasa-tunggal dan inverter fasa-majemuk. Salah jenis inverter fasa
majemuk adalah inverter 3-fasa. Beberapa aplikasi penting inverter 3-fasa
di antaranya adalah untuk menghasilkan tegangan tiga fasa dari sumber
energi terbarukan, yang umumnya menghasilkan sumber tegangan DC, se-
hingga sumber tersebut dapat diintegrasikan di grid atau jala-jala AC suatu
sistem tenaga listrik. Aplikasi penting lain dari inverter 3-fasa adalah untuk
mengendalikan motor listrik 3-fasa dan motor listrik DC tanpa sikat yang
menggunakan komutator elektronik untuk menghasilkan tegangan AC den-
gan kecepatan perubahan atau frekuensi yang dapat diubah-ubah. Inverter
3-fasa jenis ini biasanya diintegrasikan dengan unit kendali elektronik, se-
hingga menghasilkan suatu sistem kendali kecepatan putar motor listrik
atau lazim disebut sebagai sistem variable frequency drive) atau variable
speed drive.

Ditinjau dari sisi jenis suplai dayanya, motor listrik dapat dibagi atas
motor listrik arus searah (DC) dan motor listrik arus bolak-balik. Pada
hakikatnya motor listrik membutuhkan arus bolak-balik untuk mengatur
putarannya. Motor DC misalnya membutuhkan sebuah sikat atau komuta-
tor untuk memutar atau membolakbalikkan arus listrik yang mengalir pada
belitan rotornya. Jika hal tersebut tidak dilakukan, maka motor listrik DC
tidak dapat berputar. Oleh karena sikat memiliki kekurangan di antaranya
potensi munculnya percikan api dan keterkikisan akibat gesekan pada sam-
bungan belitan rotor yang berputar dengan belitan suplai daya listrik DC-
nya, maka komutator elektronik diperkenalkan. Komutator elektronik ini
isinya tidak lain adalah inverter 3-fasa.

6.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

1. Sebutkan jenis-jenis motor listrik yang Anda kenal, dan buatlah di-
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6.4. PERSIAPAN ALAT DAN BAHAN

agram kategorinya atau klasifikasinya untuk menguraikan jawaban
Anda!

2. Ditinjau dari bentuk susunan belitan stator dan rotornya atau dari
sisi belitan eksitasinya, sebutkanlah jenis-jenis motor listrik DC!

3. Jelaskan perbedaan antara motor serempak dan motor tidak serem-
pak! Sebutkan dan jelaskan fenomena utama yang membedakannya!

6.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

1. Komputer dekstop/laptop dengan program SPICE yang sudah terin-
stall di dalamnya.

2. Mikrokontroler kit yang berfungsi untuk membangkitkan sinyal pulsa.

3. Osiloskop analog/digital untuk mengukur sinyal-sinyal analog dan dig-
ital.

4. Perangkat Suplai Daya Listrik (Power Supply).

5. Komponen-komponen resistor, kapasitor, induktor, mikrokontroler,
optocoupler TLP250, MOSFET IRFP460 atau MOSFET IRF150,
Power Diode IN4004 (rating di atas 230V), MOSFER Driver IR2110,
dsb.

6.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

6.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk beberapa rangkaian elektronika daya yang akan dipelajari. SPICE

6.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but. SIM
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MODUL 6. INVERTER 3-FASA DAN KENDALI MOTOR LISTRIK

6.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

6.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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MODUL 7
Inverter Tiga-Fasa Terkoneksi
Grid

Daftar Isi
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7.3 Soal-soal Teori Dasar . . . . . . . . . . . . . . . . 54

7.4 Persiapan Alat dan Bahan . . . . . . . . . . . . . 54

7.5 Pelaksanaan . . . . . . . . . . . . . . . . . . . . . . 54

7.5.1 Pemrograman SPICE . . . . . . . . . . . . . . . 54
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7.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu menjelaskan ruang aplikasi dan cara
menerapkan inverter DC-AC tiga-fasa dalam sistem grid AC dan sis-
tem penggerak.

2. Praktikan/mahasiswa mampu memahami dan menjelaskan prinsip
kerja inverter DC-AC tiga-fasa.
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MODUL 7. INVERTER TIGA-FASA TERKONEKSI GRID

7.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ratings of Power Diode Voltage Rating: upto 4000 V Current Rating:
upto 3500 A Upper Frequency: 1 kHz ON State Voltage Drop: nearly 1 V

7.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

7.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

7.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

7.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk beberapa rangkaian elektronika daya yang akan dipelajari.SPICE

7.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but.SIM
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7.6. RANGKUMAN

7.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

7.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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MODUL 8
Pengisi Baterai Listrik
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8.1 Tujuan dan sasaran

Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami fungsi dari
piranti-piranti dan komponen-komponen penting yang digunakan dalam
rangkaiam elektronika daya.

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari piranti-
piranti dan komponen-komponen penting yang digunakan dalam rangka-
iam elektronika daya.
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MODUL 8. PENGISI BATERAI LISTRIK

8.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ratings of Power Diode Voltage Rating: upto 4000 V Current Rating:
upto 3500 A Upper Frequency: 1 kHz ON State Voltage Drop: nearly 1 V

8.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

8.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

8.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

8.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk beberapa rangkaian elektronika daya yang akan dipelajari.SPICE

8.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but.SIM
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8.6. RANGKUMAN

8.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

8.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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Aplikasi Elektronika Daya
pada Sistem Transmisi AC
Fleksibel (FACTS)

Daftar Isi
9.1 Tujuan dan sasaran . . . . . . . . . . . . . . . . . 61
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9.5.1 Pemrograman SPICE . . . . . . . . . . . . . . . 62
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9.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu mengenal dan memahami fungsi dari
piranti-piranti dan komponen-komponen penting yang digunakan dalam
rangkaiam elektronika daya.

2. Praktikan/mahasiswa mampu menjelaskan prinsip kerja dari piranti-
piranti dan komponen-komponen penting yang digunakan dalam rangka-
iam elektronika daya.
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MODUL 9. APLIKASI ELEKTRONIKA DAYA PADA SISTEM TRANSMISI AC
FLEKSIBEL (FACTS)

9.2 Landasan Pemahaman
Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ratings of Power Diode Voltage Rating: upto 4000 V Current Rating:
upto 3500 A Upper Frequency: 1 kHz ON State Voltage Drop: nearly 1 V

9.3 Soal-soal Teori Dasar
Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

9.4 Persiapan Alat dan Bahan
Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

9.5 Pelaksanaan
Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

9.5.1 Pemrograman SPICE
Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk beberapa rangkaian elektronika daya yang akan dipelajari.SPICE

9.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but.SIM
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9.6. RANGKUMAN

9.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

9.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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MODUL 9. APLIKASI ELEKTRONIKA DAYA PADA SISTEM TRANSMISI AC
FLEKSIBEL (FACTS)
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MODUL 10
Aplikasi Elektronika Daya
pada Sistem Energi
Terbarukan
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10.1 Tujuan dan sasaran
Tujuan dan sasaran yang ingin dicapai setelah melaksanakan praktikum
pada modul ini antara lain adalah:

1. Praktikan/mahasiswa mampu memahami dan menjelaskan peranan
penting rangkaian elektronika daya pada sistem pembangkit listrik
berbasis energi baru dan terbarukan.

2. Praktikan/mahasiswa mampu memahmi dan menjelaskan prinsip kerja
unit penjejak titik daya maksimum atau unit maximum power point

65



MODUL 10. APLIKASI ELEKTRONIKA DAYA PADA SISTEM ENERGI
TERBARUKAN

tracing (MPPT), dan peranannya dalam sistem pembangkit listrik
berbasis sumber-sumber energi terbarukan.

10.2 Landasan Pemahaman

Sebelummemulai praktikum, praktikan/mahasiswa perlu memiliki landasan
pemahaman yang baik atau teori-toeri dasar terkait dengan topik yang akan
dipraktikumkan. Mahasiswa juga dituntut untuk aktif menggali informasi
atau pengetahuan mengenai topik praktikum terkait, sehingga mampu men-
jawab pertanyaan-pertanyaan mendasar yang diberikan pada sub-bab selan-
jutnya.

Ratings of Power Diode Voltage Rating: upto 4000 V Current Rating:
upto 3500 A Upper Frequency: 1 kHz ON State Voltage Drop: nearly 1 V

10.3 Soal-soal Teori Dasar

Sebelum memulai praktikum, praktikan/mahasiswa perlu memahami dan
menjelaskan teori-teori dasar terkait praktikum yang akan dijalakankan.
Di bawah ini adalah pertanyaan-pertanyaan yang wajib dijawab oleh ma-
hasiswa sebelum memulai praktikum. Siapkan lembaran khusus untuk men-
jawab pertanyaan-pertanyaan tersebut.

10.4 Persiapan Alat dan Bahan

Sebelum memulai praktikum, praktikan/mahasiswa perlu mempersiapkan
beberapa peralatan ukur dan bahan-bahan praktikum. Alat dan bahan
yang perlu disiapkan adalah sebagai berikut:

10.5 Pelaksanaan

Setelah mempersiapkan alat-alat dan bahan-bahan praktikum, selanjutnya
praktikan/mahasiswa akan melaksanakan tahapan praktikum yang akan
diuraikan pada sub-sub bagian berikut ini.

10.5.1 Pemrograman SPICE

Pada bagian ini praktikan/mahasiswa akan menuliskan program SPICE
untuk beberapa rangkaian elektronika daya yang akan dipelajari.SPICE
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10.6. RANGKUMAN

10.5.2 Hasil Simulasi dan Analisis
Setelah menuliskan program SPICE, praktikan/mahasiswa akan menganal-
isis hasil simulasi SPICE dari rangkaian-rangkaian elektronika daya terse-
but. SIM

10.5.3 Perancangan dan Pengujian Alat
Pada bagian ini praktikan/mahasiswa akan mendesain atau menseptup atau
menyusun rangkaian elektronika daya yang akan dipelajari. Setelah itu
rangkaian tersebut akan diuji dengan cara mengukur parameter-parameter
rangkaian.

10.6 Rangkuman
Setelah menjalani praktikum, praktikum/mahasiswa wajib merangkum be-
berapa hal dan melaporkan secara umum hasil pelaksanaan praktikum.
Adapun hal-hal yang perlu dirangkum adalah sebagai berikut:
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